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PREFACE

Welcome to the Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade
Guide. The Insbridge Rating and Underwriting (IBRU) System is a browser-based, multiplatform
insurance rating and underwriting technology solution that provides integrated management for
every aspect of the rate definition and modification process. This guide will help with the
installation of the Insbridge Rating and Underwriting System.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others
tasked with installing and configuring the IBRU system and associated databases.

PLANNING YOUR IBRU SYSTEM

Prior to installation, you should have an idea of the type of setup you want to create. What kind of
equipment do you have available and how many environments do you need? If you do not have
everything completely planned out, you can still proceed. Environments can be removed or added
later on. The Oracle Insurance Insbridge Rating and Underwriting system (IBRU) is expandable
and can accommodate a few different configurations.

For more on planning your IBRU system, please see the Insbridge Implementation Guide.

TYPES OF INSTALLATION

There are various types of installations:

Windows Environment:

o Full RateManager — This installation will install RateManager and the Insbridge
Framework Administrator (IBFA). This is for a Windows only environment, using a SQL
Server database.

o Full SoftRater for Windows Node — This installation is for existing environments that

want to add a SoftRater for Windows node to an environment. This is for a Windows only
environment. This installation also includes incorporating an Oracle Database.

Java Environment:

o Full SoftRater Installation on a Java Machine — This installation will install SoftRater
on a Java machine, using a SQL Server database.

o Full SoftRater Installation on a Java Machine — This installation will install SoftRater
on a Java machine, using an Oracle database.
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Upgrading

Upgrade — This installation is for existing customers and will take their current version of
IBRU up to version 04.05.00.

This guide is for a Full RateManager installation on a 64-bit machine.

Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Rating and
Underwriting system:

IBRU - Insbridge Rating and Underwriting System. This is the entire system.

IBFA — Insbridge Framework Administrator. IBFA is an administrative tool used to
configure Insbridge applications and setup RateManager database connections. IBFA will
be located on a Windows Server machine. IBFA/SR-WIN is an Insbridge Framework
Administrator/SoftRater for Windows.

IBSS — Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater
engine. The SoftRater engine is a multi-platform component within IBRU that executes
the rules, rating and underwriting instructions as defined by the user in RateManager.
IBSS is usually located on a Java machine. IBSS/SR-JAVA is an Insbridge SoftRater
Server/SoftRater for Java.

SoftRater Node — A SoftRater node is either an IBFA (without RateManager) or IBSS
instance on a physical environment.

SoftRater Native — SoftRater Native is a remote instance of SoftRater that can execute
rules and rating logic in environments where access via the SoftRater web-services is not
desired or possible.

RM — RateManager. RateManager is a component within IBRU that enables users to
manage the product definition and modification process, including rating and underwriting
logic.

SR — SoftRater. The engine that executes the rating, rules and underwriting instructions
defined within RateManager. The rating environment for runtime execution and
processing of business content. SoftRater can be further defined by the operating system
where it has been loaded.

SR-WIN — SoftRater for Windows. This is also another name for IBFA.

SR-JAVA — SoftRater for Java. This is also another name for IBSS.

SRP — SoftRater Packages. A package that holds all the RateManager logic for a specific
program and version.

VFS — Virtual File Servers. Virtual file server management allows you to access

environments that are located on other machines in different locations where packages
can be downloaded.
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Package Location — A pointer to a location where SoftRater Packages (SRP’s) are
stored.

Physical Environment — A physical environment is generally referred to as a physical
machine.

Authoring Environment — The physical machine where RateManager is installed.

Rating Environment — The physical machine(s) where SoftRater is installed. This is
typically the same as a SoftRater node.

Logical Environment — An environment created for a subscriber in IBFA. It defines
package location, engine location and database location in addition to several other
supporting data items. This environment is used for rating and/or SRP management.
Each database connection will have a logical environment.

Related Documents

For more information, refer to the following Oracle resources:

The Oracle Insurance Insbridge Rating and Underwriting Operating Environments for
Hardware and Software.

You can view this guide on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

Manual History

New editions incorporate any updates issued since the previous edition.

Publication Product

Edition Number Version Publication Date Comment
~1% Edition P01-702-01 R 4.0.1 08/31/2010 Updated for 64-bit /
Windows 2008
2" Editon  P01-702-02 R 4.1 December 2010 Update Release
3" Edition P01-702-03 R 4.5 May 2011 Update Release
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Chapter 1

SYSTEM REQUIREMENTS

Server Requirements

IBRU installers should be familiar with managing a Windows server. For a 32-bit machine, please see the
Insbridge RateManager Installation Guide.

Required Components

The following components are required prior to running the installation. Failure to have the required
components may result in an installation error.

o A full installation of Microsoft Windows Server 2008 for 64-bit is required
e Microsoft .NET Framework version 3.5

e IS —Internet Information Services version 6.0 or 7.0

e |IS 6 Metabase Compatibility

e Web Server (IIS) — Static Content is required

e WCF http activation needs to be enabled

¢ MSMQ - Microsoft Message Queuing Services — basic functionality only.
¢ JRE —Java Runtime Environment

e Insbridge User Account

INSBRIDGE LOCAL USER ACCOUNT SETUP

Before starting the installation, create a local user account where the Insbridge Framework is being
installed. This user needs to be a member of the User group and requires certain privileges in order to
fully control the entire IBRU environment. For ease of installation and if the server is dedicated to the
Insbridge Rating and Underwriting System, it is suggested that this user be added to the local machine
Administrators group.

If the installer has permissions, an Insbridge user can be created during the installation.
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To Create a New User:

1. Select Start->Administrative Tools-> Server Manager.

2. Select Configuration—>Local Users and Groups.

3. Select Users.

4. Right click and select New User.

Ez Server Manager

File Action View Help

(O %]

BRI =

% Server Manager (WINSRPOO1)

5 Roles

Features

g Diagnostics

= aﬁ Configuration

Task Scheduler

9 ‘Windows Firewall with Advs

.5,7;5._ Services
WHI Control
= %ﬂ Local Users and Groups

] users
] Groups

22 sStorage

De———

Actions

Mame Full Marme Descripkion
“_’,;J.Qdmin Account for IGEBU IT Access Do not change
!,',yndministrator Built-in account: for administering the. ..
e - e —pessto k..,
i New User EHE
a
2 Username: ||
Full name: I
Description: I
Fassword: I
Canfirm password: I

¥ User must change password at nest logon
= User cannot changs password

™| Password neven expires

[~ Account is disabled

Help Create I

Cloze

Users
Mare Actions
Insbridge

More Actions

Figure 1 Creating New User

5. Add an Insbridge User. The Insbridge User should be assigned to the local Users group and have

the same permissions as the internet guest account.

Ideally, the Insbridge user should be added to the local Administrators group. If the Insbridge user
cannot be a part of the local administrators groups, please make sure that the Insbridge user has

permissions on the Insbridge Messaging Service and the Insbridge Task Manager Service.
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Insbridge Properties I

Femaote contral | Teminal Services Profile | Dial-in I
General | tdember OF I Prafile I E nvironrment | Sezziohz

L Inzbridge

Eull name: Ilnsbridge

Description: Inzbridge Llzer

™| User must change password|at nest logon
¥ Uszer cannot change pazswaord

¥ Password never expires

[T Account iz dizabled

[T Sccount iz locked out

k. I Cancel Smply Help

Figure 2 Adding User information

6. Click OK. Your Insbridge user will be created. User information may not populate the Server
Manager screen immediately. Click Cancel to close the screen and return to Server Manager.
Please keep the Insbridge user information close at hand. You will need it for the first installation.

NOTE: You also can create the Insbridge User from within the install. If you create an Insbridge user from
the install, you may not be able to set the permissions you need. Please be sure to verify the
proper permissions are in place before continuing.

Insbridge User Password

The password can be set to any password that meets your company standards. The IBRU administrator
must make note of the password for future configuration.

For ease of maintenance, the IBRU user should not have to change the password and the password
should never expire.
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The installation will automatically apply the Insbridge user name and password to the necessary libraries,
virtual directories and, if used, Internet Proxy settings in IBFA. If you change the Insbridge user password,
you will have to change the password in all three of the Insbridge Com+ libraries, all three of the Insbridge
virtual directories and, if you are using it, the Internet Proxy settings in IBFA.

Please note that if your company requires passwords to be re-set, you will have to make changes to the
COM+ Application libraries, virtual directories and if you are using it, the Internet Proxy settings in IBFA
after you change your password. You also may re-install the application. This will recreate the COM+
applications, virtual directories and IBFA instance with the updated Insbridge user password. Be aware
that re-installing the application will also reset security settings in IBFA as well.

Windows 2008 Permissions:

Windows 2008 requires certain permissions be in place prior to running the install. The permissions
required for Windows 2008 are:

e For Windows 2008 Server — IIS 6 Metabase Compatibility

e For Windows 2008 Server — Web Server (lIS) — Static Content is required

e For Windows 2008 Server — WCF http activation needs to be enabled

E_ server Manager [_ O] x|

File Action View Help
L

_-':;\. * Roles

ﬁ;_-] Features

_i Diagnostics ﬁ < View the health of the roles installed on your server and add or remove roles and features.
it Configuration =
=5 Storage

-~ Web Sserver (IIS) E Web Server (II5) Help il
Provides a reliable, manageable, and scalable Web application infrastructure.
~! Role Status 7 Go to Web Server (115)

Messages: None
System Services: 3 Running, 1 Stopped

Events: Nene in the last 24 hours

~| Role Services: 13 installed St Add Role Services
R Role Servi

Role Service | Status | % Remave Role services
Cw Web Server Installed
] Common HTTP Features Installed ]
a Static Content Installed
a Default Document Installed

Directory Browsing Mot installed

HTTP Errors Not installed

HTTP Redirection Notinstalled
= Application Development Installed
& ASP.NET Installed
== NET Extensibility Installed

ASP Notinstalled

CGI Notinstalled
] ISAPI Extensions Installed
] ISAPI Filters Installed

Server Side Indudes Notinstalled

Health and Diagnostics Mot installed
HTTD | Annina KMt inctzllad LI

%‘l( Last Refresh: 5/26/2011 2:09:41PM Configure refresh

Figure 3 Windows 2008 Permissions
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To Add a Role:

1. Start-> Administrative Tools—> Server Manager—-> Roles—> Web Server (11S)-> Add Role Services.

E: Server Manager

File Action View Help
= 2m
f}.! Roles -/
@::] Features

_j Diagnostics | %" View the health of the roles installed on your server and add or remove roles and features.
Gt configuration =
22 Storage —

Basic Authentication Mot installed
Windows Authentication Mot installed
Digest Authentication Mot installed
Client Certificate Mapping Authentication Mot installed
115 Client Certificate Mapping Authentication Mot installed
URL Authorization Mot installed
.‘i, Request Filtering Inztalled
IP and Domain Restrictions Mot installed
Performance Mot installed
Static Content Compression Mot installed
Dynamic Content Compression Mot installed
.‘g'i_._. Management Tools Installed
.@'J 115 Management Console Installed
II5 Management Scripts and Tools Mot installed
Management Service Mot installed
.‘g'i_._. IIS & Management Compatibility Installed
.@'J 115 & Metabase Compatibility Installed
15 6 WMI Compatbility Mot installed
II5 6 Scripting Tools Mot installed
1IS & Management Console Mot installed
FTP Publishing Service Mot installed
FTFP Server Mot installed
FTF Management Console Mot installed
Description:

1156 Management Compatibility provides forward compatibility for
your applications and scripts that use the twa IIS APIs, Admin Base
Object (ABO) and Active Directory Service Interface (ADSI). You can
use existing IIS 6 scripts to manage the 115 7 Web server.

Figure 4 Adding IIS 6 Metabase Compatibility

2. Install IIS 6 Metabase Compatibility.

Extended Permission Required by the Insbridge User

In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to both the
Insbridge Message Service and the Insbridge Task Manager Service. If the Insbridge user account will
not have full administrative permissions on the server where the Insbridge Framework is installed, then
certain operations from IBFA will not be available. A system administrator may be required to start the
Insbridge services from the server.
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DATABASE USER ROLES AND PERMISSIONS

If a more granular approach is required for management of security of the IBRU databases, then the
following guidelines can be used to set permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the Insbridge
Rating and Underwriting System will fail. An experienced database administrator's expertise is
highly recommended before making any security changes.

Recommended RateManager Permissions:

It is recommended that the IBRM and IB_CLIENT database user have a database owner (db_owner) role.
db_owner access is needed to execute the Insbridge stored procedures and have full access to the
Insbridge schema. Disk Admin permissions are also recommended in order to create backups within
RateManager.

For the IBRM and IB_CLIENT databases, if db_owner permissions are not possible, manual steps will

need to be performed to update the databases. If disk admin permissions are not allowed, backups will
have to be done outside of RateManager.

Recommended SoftRater Permissions:

The recommended permissions are required for new tables to be created in the SoftRater (IBSR)
database dynamically when or if a new line of business SRP (SoftRater Package) is loaded to the
SoftRater system. If the recommended permissions are not possible, manual steps will need to be
performed that will allow for packages to be loaded.
SoftRater can utilize three database types, SQL Server, Oracle and DB2.
e Insbridge SoftRater SQL Server Database.
It is recommended that the Insbridge login be granted permission to connect to the database
engine and be enabled. It is also recommended that the Insbridge login be mapped to the
Insbridge database with the db_owner role checked.
e Insbridge SoftRater Oracle Database.

It is recommended that the Insbridge user be granted, as defaults, the “CONNECT” and
“RESOURCE” Roles.

e Insbridge SoftRater DB2 Database.

It is recommended that the Insbridge user be granted “Connect to database”, “Create Tables”,
“Create packages” authorities.

Manual steps will be detailed out in the areas where they will be noticed.
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MICROSOFT SQL SERVER

Microsoft SQL Server should not be installed on the same machine where the Insbridge web applications
reside. The SQL Server should reside on a separate host from the IBRU web front end with a properly
configured network connection from the web server front end to SQL Server. Testing can be performed
by using the Data Sources application in Administrative Tools to make a default connection to the
database server.

NOTE: All these settings are available during installation of SQL Server or by using SQL Server
Enterprise Manager, and right clicking the server and selecting properties.

If any of these settings conflict with existing application’s databases residing on the SQL Server,
then a separate instance is required.

Depending on the load expected, the databases can be placed on a separate SQL Server machines that
can either be independent or shared as long as the following conditions are met.

e Server Authentication: Should be set to SQL Server and Windows Authentication mode.

e Collation and Sort Order: Currently supported is the default SQL Server collation using
SQL_Latinl_General_CP1_CI_AS and sort order plus case sensitivity using Latinl_General_BIN
as the server collation. The security database (IB_CLIENT) supports the default SQL Server
collation using SQL_Latin1_General CP1_CI_AS. The RateManager and SoftRater databases
can use either case sensitive or non-case sensitive. Please check with Oracle Insurance for any
guestions regarding database server sort orders or collations.

NOTE: For SQL Server, please make sure the SQL Server Client is installed.

E-Delivery

Prior to installation, please make sure the source machine(s) where IBRU will be loaded has an unzip
utility. An unzip utility for most platforms is available on the E-Delivery download page.

Documentation from E-Delivery is in PDF format. Prior to installation, please make sure the source
machine(s) where IBRU documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers you have
downloaded and the corresponding file name. You may be asked to provide the part numbers or the
filename if you contact Oracle Insurance Support.
The installation downloads you can select are:

e Insbridge IBRU Install — This is required for all RateManager installations

o SoftRater for WebSphere — This is required if you are using WebSphere

o SoftRater for WebLogic — This is required if you are using WebLogic
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e SoftRater for Jboss — This is required if you are using Jboss

e Documentation — It is recommended that you download the documentation. Installation guides
and user guides are located here.

The 04.05-Insbridge-IBRU folder contents:

Databases

¢

DB2
- SoftRater — IBSR
o DDL
Oracle
- SoftRater — IBSR
o DDL
o Update:Usp_IBSR_v04.05.00.oracle
SQL Server
- RateManager — IBRM
0 Latinl _General BIN
» DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General CP1_CI_AS
» DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security — IB_CLIENT
0 SQL_Latinl_General CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak
- SoftRater — IBSR
0 Latinl_General_BIN
= DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl General CP1 CI_AS
» DATABASE_BACKUP_IBSR_TEMPLATE.bak
o Update:Usp_IBSR_v04.05.00.sql

IE7_IE8 Users

¢
L

Insbridge IE7 Active X Control Update PDF
RateManager_IE7_IE8.exe

Oracle Bl Publisher

L

OBI_PUBLISHER.exe

Oracle Client

L

Oracle_client.exe

Oracle Insurance — Insbridge Rating and Underwriting (x64).exe

You will be required to run the installation file and create the IB_CLIENT database for any new
installation. The other folders and files may not be needed, depending upon the kind of setup you want.
Everything for a Windows only installation is in the 04.05.00-Insbridge-IBRU folder. If you want to
incorporate a Java environment, please download the corresponding SoftRater file. SoftRater downloads
are not required if you are running in Windows only.
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Chapter 2

FULL RATEMANAGER INSTALLATION

This installation will install RateManager and the Insbridge Framework Administrator (IBFA). This is for a

Windows only environment, using a SQL Server database.

Before installing, please verify that the system requirements
are in place. ESTE T
_ _ _ _ R borng
The installation should be performed in the following order:
1. Install the IBRU application. INSTALL:
2. Assigning Insbridge access to the Registry. 9
QB Publisher
3. Assigning permissions to the Insbridge User for the e
Windows Temp Folder. This is necessary for MSMQ. SUBSCRIBER
The Application Pool Identity must also be given e
permissions for the Windows Temp Folder.
4. Assigning permissions to the Insbridge User for the P —
Insbridge Folder Controller
5. Creation of the IBRU databases is next. There are two A
databases that must be in place.
a. |B_Client CREATE:
b. IBRM i
6. Enter IBFA and Configure: RM — 1o handle
— testing/rating.
a. Create your subscriber. §, QA_SR - This
o envirenment
b. Add database connections. - L
c packages o be
c. Create your logical environments © consumed by G
. : © \_./_\
©
Verifying Component Services. E
. . . o
Allowing for WCF Activation. | PURPOSE of this Physical
) 0 Environment
Install OBI Publisher. 5 This ervironment is for the
. . E creation of rating programs
10. Start Insbridge Message Service. s
‘g This envlron_nnem also holds the
11. Login to RateManager and perform IBRU database |5 security Informeation.
updates. NA =TT mmmmsmmmssssssssseees
12. Create Backup of Registry Key.
IE_CLIENT
Security
5]
You must run as Administrator. e| e
w Sarver =
- v
% |B|-Jt.nh-1tsna
holds Rating &
Rules
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STEP 1 — INSTALL INSBRIDGE RATING AND UNDERWRITING

1. Begin with the Oracle Insurance - Insbridge Rating and Underwriting Install file. For a 64-bit
installation, please make sure you have:

Oracle Insurance - Insbridge Rating and Underwriting (x64).exe

NOTE: The installation program requires that the installer have administrator rights on the machine
where the install is occurring. You may receive a message that an unidentified program wants
access to your computer. Please Allow.

NOTE: Please close all open applications before running the Oracle Insurance — Insbridge Rating and
Underwriting file.

2. Open the Oracle Insurance — Insbridge Rating and Underwriting file. A Welcome screen will be
displayed.

fii Dracle Insurance - Insbridge Rating and Underwriting 04.05.00 Setup [_ O] |

4 QOracle Insurance Insbridge Rating and Underwriting

It iz strongly recommended that you exit all \Windows programs befare running this setup program.

Click Cancel to quit the setup program, then cloze any programs pou have running. Click Mest to
continue the inztallation,

WAARMIMG: This program iz protected by copyright law and international reaties.

Unauthorized reproduction or distribution of this program, or any portion af it may result in severe civil
and criminal penalties, and will be progecuted to the maximum extent possible under law,

ORACLE

INSURANCE

Cancel |

< Back

Figure 5 Installing Insbridge

3. Click Next to continue.
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fiz? Dracle Insurance - Insbridge Rating and Underwriting 04.05.00 Setup [_ O] |

Destination Folder ORACLE

Select a folder where the application will be installed. INSURANCE

The Yize Inztallation ‘wizard will ingtall the files for Oracle Inzurance - Insbridge Bating
and Underwriting in the following folder.

To inztall into a different folder, click the Browse button, and select another folder.

“'ou can choose nok ko install Oracle [nsurance - Insbridae Bating and Undenariting by
clicking Cancel to exit the ‘wize [nztallation \Wizard.

Deztination Folder

C:AProagram FilestOraclet GBS nzbridaet, Browse. . |

YWize Inztallation ‘wizard [R]

< Back I Hest > I Cancel

Figure 6 Entering the Destination Folder for Insbridge

Choose the location where the Insbridge installation will be installed. A default installation folder will
be created for all new installs. This will be the location for all future installations for Insbridge
applications. Select Browse if you want to install in a different location. After selecting a location, click
Next to continue.
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fiz? Dracle Insurance - Insbridge Rating and Underwriting D4.05.00 Setup [_ O] |

Logon Information DRACLE‘

The following logor information is used by Insbridge. INSURANCE

Specify a user account to be used by the application, either for running a service ar for
logging onto other zervers. Uze the Browse button to choose users from wour network.
Far domainz, uzer names must be in the format of DOMAINSU zert ame.

Uszer MName: IInsI:uriu:Ige Browse. . |

Pazsword: I [T1[1]

Create Mew Uzer...

YWize Inztallation ‘wizard [R]

Figure 7 Logon Information

5. Enter the Insbridge user name and password for the local user account you set up earlier. The
logon information screen will be displayed. You must specify a user account to be used by the
application. Please use the Insbridge user account that you set up on page 9.

NOTE: You can Create a New user at this point, if needed. Click the Create New User button to be
placed on New User screen to setup an Insbridge user.

6. Click Next to continue.
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fiz? Dracle Insurance - Insbridge Rating and Underwriting D4.05.00 Setup [_ O] |

Select Features DRACLE‘

Fleaze select which features you would like to install.

INSURANCE
& {Q vI Inzbridge Rating & ndenwriting Feature Description:
e %’ Ratetanager Oracle Insurance Inzbridge F ating and
""""" =~ | IBFA IIndenwriting is a “eb-bazed rating, rles, and

e D vI Oracle Bl Publisher Reparts undenwriting systern.

T hiz feature will be inztalled an the lacal hard
drive.

T hiz feature requirez KB on vour hard drive. [t
has 2 af 2 subfeatures zelected. The subfeat...

Current lacation:
C:%PROGRAM FILESSORACLESIGEUNHSERIDGE

YWize Inztallation ‘wizard [R]
Dizk Cost Reszet

Figure 8 Selecting Features for Installation

7. The next screen will list the applications to be installed. To expand the options and view details, click
on the downward arrow. All features are checked for installation. RateManager is the only one that
you will be allowed to not install. Click Next to continue.

Options are:

e Insbridge Rating and Underwriting:
The default option is: Entire feature will be installed on local hard drive.
You will not be able to opt out of this selection.

e RateManager:
The default option is: Entire feature will be installed on local hard drive.
You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

e IBFA:
The default option is: Entire feature will be installed on local hard drive.
You will not be able to opt out of this selection.

e Oracle Bl Publisher:
The default option is: Entire feature will be installed on local hard drive.
You will not be able to opt out of this selection.
This option does not install the OBI Publisher. Only the templates required by the IBRU
application will be installed on local hard drive.
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I S

i'él Oracle Insurance - Insbridge Rating and Underwriting 04.05.00 Setup

ORACLE’

Ready to Install the Application
Click Mext to begin inztallation.
ick Mext to begin installabion INSURANCE

Click the Back button to reenter the inztallation information or click Cancel to exit
thie wizard.

Wiize Inztallation YWizard [R]

Cancel |

Figure 9 Ready to Install

A Ready to Install screen will be displayed. If you are ready, click Next. Otherwise click Back to check

8.
the options you want to install.

jii Oracle Insurance - Insbridge Rating and Underwriting Setup M= B |
Updating System ORACLE'
The features you selected are currently being installed.
Y v g INSURANCE

Walidating install...

Wize Inztallation *izard [R]

Figure 10 Installation Progress
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fizt Oracle Insurance - Insbridge Rating and Underwriting Setup [_ O] |

4  Oracle Insurance Insbridge Rating and Underwriting

Click. the Finizh buttan ba exit thiz installation.

ORACLE

INSURANCE

< Back I Finizh I Eancel |

Figure 11 Install Completion Screen

9. Click Finish to finish the installation. The installation should complete successfully.
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STEP 2 — VERIFYING REGISTRY ACCESS

NOTE: If you use Registry Editor incorrectly, you may cause serious problems to the operating system.
These problems may require you to reinstall your operating system. Insbridge cannot guarantee
that you can solve problems that result from using Registry Editor incorrectly.

By default, only administrative and power user accounts have full permissions over this key. The
Insbridge user must also be given full control over the following registry key:

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge

Verifying Permissions for the Registry Access

1. Selecting Run from the Start Menu.
2. Type regedt32. Click OK. The Registry Editor will open.

3. Browse to HKEY_ LOCAL_MACHINE. Select SOFTWARE->Insbridge.

&' Registry Editor

File Edit View Favorites Help

[E1-188 Computer Name Type | Data
[l | HKEY_CLASSES_ROOT ab]{Default) REG_SZ {walue not set)
[+ |, HKEY_CURREMT_USER
E| . HEEY _LOCAL_MACHIME
- . BCDOOOOOOOO
. COMPOMEMTS
HARDWARE
. SAM
. SECURITY
=1 | SOFTWARE
. Classes
Clients
=]
. Hewlett-Packard
Expand
= 13
Find. ..

-
H - TS

Delete
Rename

e[ P e P -
- - - - B - - (- - - - B
=
&
=3
o

el [ WO
[+ [, SYSTEM
[~ |, HKEY_USERS
[#- ) HKEY_CURRENT_COMFIG

Copy Key Mame

‘Cnmputer\HKEV_LOCAL_MACHINE\SOFTWARE\InshrldgE S

Figure 12 Configure Registry Access Windows Server
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4. Right click and select Permissions.
5. Scroll through the users. Select the Insbridge user.

6. Verify that the Insbridge user has Full Control.

7. If the Insbridge user does have Full Control, cancel out of the registry and continue with the

installation.

8. If the Insbridge user does not have Full Control, change permissions to allow for Full Control.

Save your entry and close out the registry. Continue with the installation.

9. If the Insbridge user is not listed, follow the step to add the Insbridge user.

Adding the Insbridge User:

10. From the Permissions screen, click Add.

11. On the Select Users or Groups popup, you can leave the defaults for the Object Types and

Locations or enter the values you require.

5Select Users or Groups E

Select thiz object type:

ILlsers, Groups, or Built-in securnity principals Object Types...

Erarn thiz location:
IWINSHF’Dm Locations. ..

Enter the object names to select [eRamples]:
inzhridgs LCheck Mames

i

Advanced... | 1] 4 I Cancel

4

Figure 13 Entering the User

12.

13. Once the name is listed, click OK.

Enter in the user name (Insbridge) and click Check Names. If the user name is found, it will be
listed. If the name is not found, an error screen will be displayed. Cancel out and to return to the
Select Users or Groups popup. Click Advanced to search. To search the directory, click Find
Now and scroll through the list until you find the user name you need. If the user name is not
listed, return to User Accounts and verify the user name was created.
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. Permissions for Insbridge I
Security |

Group or uger names:

5% CREATOR OwWNER

52 SYSTEM

1 Inzbndge ['IHSREPO0T 4 nsbridge]
"ﬂ,.i‘-.dministratl:urs [*IMSRPOOT SAdministrators)
‘ﬂ, zers WINSRPOOT\zers)

Add... | Bemove |
Permizzionz far Inzbridae Al Deny
Full Control O
Read O
Special permizsions O O

For zpecial permizzions ar advanced settings, Advanced |
click Advanced. =
Learn about acces: control and permizsions

k. I Cancel | Apply |

Figure 14 Applying Permissions for Insbridge User

14. On the Permissions screen, make sure the Insbridge user is highlighted and check to give Full
Control to the entire Insbridge key.

15. Click OK.

16. Close the registry and continue with the install.
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STEP 3 — ASSIGNING PERMISSIONS — WINDOWS TEMP FOLDER

Permissions must be assigned for the Windows Temp Folder for MSMQ and for the application pool
default identity. Prior to assigning permissions, please verify the default application pool identity.

Identifying the Application Pool Default Identity:

aronE

Open IIS. Start->Administrative Tools=>11S Manager.
Expand the server and select Application Pools.

Select the DefaultAppPool.
Right click and select Advanced Settings.
Take note of the Identity under Process Model. This user will need to be added to the Windows

Temp file. In this example, the Identity is NetworkService.

HE Internet Information Services (IIS) Manager

@ L=y [;.? ¥ WINSRPOOL » Application Poals

File  View Help

< - [ |£"_. |&,
&5 Start Page
=93 WINSRPOO1{wWINSRPOOL\Admini
J Application Pools
& Sites
=4 Default Web Site
-] aspnet_client

.
'"-._.
[+

Qg! Application Pools

This page lets you vir
applications, and pro
Filter:

Mame =

=) Classic .NET &pp
[} DefaultAppPool

Advanced Settings

B (General) =
NET Framework Version va.0
Enable 32-Bit Applications False
Managed Pipeline Mode Integrated
DefaitippPod
Queue Length 1000
Start Automatically True
B CrPu
Limit a
Limit Action MoAction
Limit Interval (minutes) 5
Processor Affinity Enabled False —
= Seor=Srrareidast SESESETEES
E Process Model
Identity NetworkService
= R ==
Load User Profile False
Maximum Worker Processes 1
Ping Enabled True
Ping Maximum Response Time {seconc 90
Ping Period (seconds) 30
Shutdown Time Limit (seconds) a0
Startin Time |imit fearnnd=) an hd
Name
[name] The application pool name is the unique identifier for the application poal.

Figure 15 Verifying Application Pool Settings
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6. Click OK to close the Advanced Settings screen.
7. Close IIS. No more information is needed from the Application Pool.

Assigning Permissions in the Windows Temp Directory:

1. Open Documents. Find the WINDOWS folder, most likely on your C drive.
2. Right click the Windows=>Temp folder.

@( }v | . = Computer - Local Disk (C:) = Windows - - lml Search
File Edit Wiew Tools Help
Organize * == Views ~ [m]Explore 23, Share
Favorite Links Mame = |v| Date modified |v| Type |v| Size |v| Tags |-|
, ORCLOBI 11192010 11:4.., File Folder
[ bocuments | Panther 11/19/2010 7:30... File Folder
!E Pictures | PLA 1/19/2008 5:11 AM  File Folder
!I} Music | PolicyDefinitions 11192010 11:1... File Folder
More 3 | Provisioning 1192008 5:11 AM  File Folder
| Reqistration 6142011 3:16 PM  File Folder
Folders w | RemotePackages 1/15/2008 3:54 AM  File Folder
. rescache a1 ﬂ, TEMP Properties |
!Ei' Favarites ;I
) | Resources 11 . - )
% Links | schCache 11 General I Sharing Security | Previous Versions I Customize I
Music
. B U1 Objectname:  C:\Windows\TEMP
!E Pictures | security i1
!EI Saved Games | ServiceProfiles 1,|r1 Gmup or uUser names:
E S?EFEhES . servin:ing 'q',lrj. g‘a_‘_SYSTEM ;I
B viceos N L B Y 1\ Tv/ORK SERVICE
1 Public . SoftwareDistribution :I.:l.,ll & insbridge {WINDD‘I\JHSbHdgE}
1% Computer . Speech 11 31 Addministratars 4 MOATS Administratan) _ILI
=4 Floppy Disk Drive | SysMsiCache i1 £ | B
12_{' Local Disk (C:) J system 11 To change pemissions, click Edit. Edit . |
: | System32 a1
¢ inetpub o OuEs oy Pemissions for NETWORK
. installs L SERVICE Allow Deny
| Perflogs j tapi 11 Modify ;I
| Program Files h 11:;5:: :Gl"ri Fead & execute +
| Program Files — — 1§1 List folder contents +
| tracin
| Users d Read +
- | Users 11 Vi
. Windows Web 11 rite vy
¢4 CD Drive (D:) Wi;l el n p 11 Special pemissions =
For special pemissions or advanced settings, ] |
click Advanced.
Leam about access control and pemmissions
| 4 Features View Conb
g ok | Canced | il |

Figure 16 Assigning Permissions for the Insbridge User on Windows Temp

3. Select Properties. The Temp Properties screen will open.
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7.
8.
9.

Select the Security tab.
Click Edit.

On the Permissions for Temp screen, select the Insbridge user and click Add. If the Insbridge
user is not found, cancel out and return to the Local Users and Groups area in Server Manager
and verify the Insbridge user was created.

Update the permissions. The Insbridge user requires Full Control.
Next, add the Application Pool identity.
Update the permissions. The Application Pool identity requires the default permissions plus

WRITE.

10. Click OK to close the Permissions for Temp screen.
11. Click OK to close the Temp Properties screen.
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STEP 4 — ASSIGNING PERMISSIONS — INSBRIDGE FOLDER

Assigning Permissions for an Insbridge Folder Location

1. Open Documents. Locate the INSBRIDGE folder, most often the Insbridge folder is located at:
C:\Program Files\Oracle\IGBU\Insbridge.

2. Right click the Insbridge folder.

n Insbridge [ _ O I
0“\ };v | . = Local Disk (C:) = Program Files = Oracle = IGBU ~ Insbridge - - lmj ISearth F=)
File Edit View Tools Help
Organize * 1 Wiews ¥ @
Eavorite Linke MName I-I Date modified I-I Tvpe I-I Size I-I Tags I-I
L COM+ 8/30§2010 £:50 PM  File Folder
[F) oocuments | Framework 4)29/2010 9:54 &AM File Folder
[E) Fictures 50K 4/29{2010 2:54 &M File Folder
ﬂ:} PMlsic | SoftRater 4/29)2010 9:54 AM  File Folder
Mare | ‘webs 4/29/2010 9:54 AM  File Folder
Faolders hd
L. Cracle ;I
= | 1GEU
Collapse
[+
&l Explore
Open
Share. ..
Fac B Scan For Ehreats. ..
| Ref
Wi Restore previous versions
;Wi gend To »
. Users
. Windo Cut
w5 ovp o SOPY
= ¥ Hetwork Delete
# AJACQY  Rename
N
e M AMSDEN R
18 AMSDE

Figure 17 Assigning Permissions for the Insbridge User on Insbridge

Select Properties. The INSBRIDGE Properties screen will open.

Select the Security tab.

Click Edit.

On the Permissions for INSBRIDGE screen, select the Insbridge user and click Add. If the

Insbridge user is not found, cancel out and return to the Local Users and Groups area in Server
Manager and verify the Insbridge user was created.

Update the permissions. The Insbridge user requires Full Control.
8. Click OK to close the Permissions for INSBRIDGE screen.

o0k ow

~
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M insbridge Properties I
-Generall Sharing  Security I Previous "-@'ersil:unsl Eustumizel

Object name:  C:\Program Files Oracleh GBS nebridge

ETDUD ar LIEel names:

52, CREATOR OWMER

82, 5YSTEM

b 8 rsbridae [w/INSRPO01 nshridge]

3
: & dminiztratars PR SEPONT S & Araimisteabars] hl
4 | B
To change pemmizsions, click Edit. W Edi.. |

Permizzions far Inzbridae Al Deny

Full contral

b odify

Fead & execute
Ligt folder contents
Read

Wribe

LCAENANANAN

|_ILI_IL

For zpecial permizzions or advanced settings,

click Advanced. Advanced

Learn about acces: control and permizsions

aF. I Cancel | Smply |

Figure 18 Setting Permission for Insbridge Folder

9. Click OK to close the Temp Properties screen.
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STEP 5 — RESTORING IBRU DATABASES IN SQL SERVER

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.
Make sure you have a SQL Server account called ibru.

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

Currently supported is the default SQL Server collation using SQL_Latinl_General CP1_CIl_AS and sort
order plus case sensitivity using Latinl_General_BIN as the server collation. The security database
(IB_CLIENT) supports the default SQL Server collation using SQL_Latin1_General CP1 _Cl_AS. The
RateManager and SoftRater databases can use either case sensitive or non-case sensitive. Please check
with Oracle Insurance for any questions regarding database server sort orders or collations.

1. Located in the Insbridge Installation Directory:

¢ SQL Server
- RateManager — IBRM
0 Latinl_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl General CP1 CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security — IB_CLIENT
0 SQL_Latinl_General CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak

2. Select the RateManager backup file you want to use, case sensitive or non-case sensitive. The
Security — IB_CLIENT file is only non-case sensitive.

3. Copy both files to an appropriate database folder on the machine where SQL Server is installed.
For example, [Drive]:\\Program Files\Insbridge\Databases. If you are unsure of a location, please
consult with your database administrator.

4. Rename files. It is not required but it is strongly suggested that the database file names be
changed from TEMPLATE to something that defines the databases more accurately. At a
minimum, it is recommended that you remove “*_ TEMPLATE” from the name. You can change the
names after they have been restored also.

5. Open the SQL Server Management Studio either on the server or remotely using either an
administrative account with sa privileges or as the sa account.

NOTE: If you do not have SQL Server Management Studio, check to see that the SQL Server Client has
been installed. For a SQL Server install, you must have the SQL Server Client installed.
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e &2 Windows Catalog
L_,_\{f Windows Exp ’:h Windows Update

. Zip

A
E.‘-. Motepad Accessaries
Adrninistrative Tools

(N Sl Server Mar
% e BEA Products

BEA Products {BEAHOME 1)
Microsaft JMET

f'!’ 1.1 Wizards Microsoft JMET Frameork SDK v, 1

I 5 ) analysis Services

0L Server Car ; ; . 4

Manager Micrasoft Wisual Studio 2005 4 Configuration Tools
Startup 4 Performance Tools
Symantec Client Securiky P G S0L Server Business Intelligence Development Studio
Intermet Explarer
Qutlook Express Dacurentation and Tukarials
Microsaoft Wisual SourceSafe

_ Remote Assistance
Log OFF E Shut Down

Figure 19 Restoring a Database to SQL Server

6. Go to Databases.

B Microsoft SOL Server Management Studio - [Object Explorer Details]
Uz Ele  Edit Yiew Tools Window Community  Help -8 X
ewcuery | [ R0 |3 Sl B @ BEBES
~ 0 X
BEETE
Comnect~ | @3 m T [£]
=] Ld Southern (0L Server 9,0,4035 - 5a) |'§ Data bases
[} Database Mew Database...
[l Security SOUTHERM|Databases 131 Item(s)
[ Server O Attach,.,
1 Replicati
3 Mansg ‘ Restore Database... -
[ Matificati Restore Files and Filegroups. .. stem Databases
SQL Ser
B Reports , atabase Snapshots
Rater_Auditing
Refresh -
-
4 B
Ready ]

Figure 20 Right Click to Restore Database
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7. Right click on Databases.

8. Select Restore Database... A separate screen will be displayed.

I Restore Database - IB_CLIENT

Select

1 General
1 Options

Server:
WINAPODMSOL

Connection:
za

4¢ View connection properties

;S Scrpt - m Help

=] E3

Destination for regtore

Select or type the name of a new or exizting databaze for pyour restore operation.

To database: IB_CLIENT |
To a point in kirme: IMDst recent possible |

Source for restore

Specify the source and location of backup zets to restare.

" From database: I j
&+ From device: IE:'\F’nglam FileshMicrozoft SOL ServerhSSOLTWMASS |
Select the backup sets to restore;
R estare | M ame I Camponett | T}Ipel Server | D atabase | Positior
v Database Full PwiDEYOOOOT IB_CLIENT_TEMPLATE 1
4] | |

Ok I Cancel |

4

Figure 21 Restoring a Database

9. Enter your IB_CLIENT database name in To Database:

10. Select From Device. Click ... to browse to the location where the database files were placed in

step 3.

11. Select your database IB_CLIENT_ xxxx.BAK, where xxxx equals the renamed file from step

4,

12. Click OK. Your database will be populated.

13. Verify your information. Check the Restore box.
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14.

15.

16.

17.

Click OK.

If the database was restored successfully, it will be displayed in the database folder. If not, please
correct any errors and try again.

Repeat for the RateManager database and any SoftRater database.

Once the databases are restored to SQL Server, you will need to create or assign a SQL Server
user account for the application. This user will be used for the connection to the databases when
setting up the connections from the Insbridge Framework Administrator. Make note of the account
you want to use. This information will be entered into the Insbridge Framework Administrator.

If backups are to be allowed from the RateManager application (see page 31 for more details),
then the ibru SQL server user account must have the Disk Administrators SQL Server role.

For ease of administration, the database user should have db_owner permissions on the
IBRM_xxxx, and IB_CLIENT databases.
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STEP 6 — CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

Open an Internet Explorer web browser either remotely on the local IBRU web server and browse to the
following location, replacing SERVERNAME with the actual server name:

http://SERVERNAME/ibfa/

= Framework Administrator - Windows Internet Explorer E”Elg‘

— 5~ | @] hpiiiLocanostibtajefault aspx] IEES

T —

fle Edt View Favorites Tools  Help

= »
" & [ & Framework Administrator I I [ IR ) = v |7k Page - i) Tools -
ORACL_E insurance Insbridge Framework Administrator Version 04.05.00 (x86)
= &
E“ C ion File [C:\PROGRAM FILES\ORACLE\IGBU\INSBRIDGE\ FRAMEWORK)3.5.0 \Insbridge.Xml]
3 SoftRater The Framework Administrator Veb will configure any Insbridge Framework Configuration file (Insbridge.xml) found on your
H network. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps
[ softData that reside on the same Framework Server share the same file.
[ Services
3 Logs Change Config File location: Browse Update
[ security
5 softlibraries Add Subscriber
L) Help The subscriber identifr is an unique number that you would like to represent your company. Please consult with an
hridoe supportg#bresentative if you have any questions.
# Mo Subscribers found.
Add Database Connection
Create or edit database connection. This database connection can be global to the Insbridgs Framework or unique to the
Subscriber,
Click on the name of the connection ko edit.
82 global
# Mo Connections Found,
)
Copyright @ 2000,2008, Crade and/or its affiiates. All rights reserved.
Done ®J Local intranet 100% -

Figure 22 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge
user full control of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control
over the Insbridge directory. Regedt->Insbridge Directory-> Security.

To continue, you will need to exact names of the databases you restored in Step 5, IBRM_xxxx, and
IB_CLIENT databases.
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There are five steps that will need to be done in IBFA:
e Step 1 - Creating a New Subscriber
e Step 2 - Adding a Global Database Connection
e Step 3 - Adding a Security Database Connection
e Step 4 — Adding an RM security Database Connection

e Step 5 - Creating a RateManager Environment

Step 1 — Creating a New Subscriber:

A subscriber is a group or collective of users and environments under a single identity. This identity is
used to manage and configure the group’s activities and databases. A subscriber may be a single
company, a group within a company, or a single person.

The ID, Name and Description are selected by you. The ID and Name are fixed after the first time you
save. These entries cannot be edited. Only the description can be edited.

1. Click on Add Subscriber on the Main IBFA screen. A separate screen will be displayed.
2. Enter the ID, Name and Description for your subscriber.

3.  When you finish entering the information, click Save. The new subscriber will now be displayed in
the list of subscribers.

2 Subscriber -- Webpage Dialog @

Subscriber
Please enter fupdate your Insbridge Customer information below,

ID: 3659
Mame: Alamere

Desc:  Alamere Insurance

Save Cancel

Figure 23 Enter ID
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NOTE: Make note of the subscriber ID number. You may need to enter this on another IBFA or IBSS
environment.

The Subscriber ID can be a 3 or 4 digit number and must unique for each subscriber. For
example, if you have an instance of IBFA on machine A, you can create a subscriber with an ID
of 100. On machine A, if you create another subscriber, you must give that subscriber a different
ID number, say 200. If you also have an instance of IBFA on a different machine, B for example,
you should duplicate the same subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using
My Oracle Support at https://support.oracle.com/.

Troubleshooting Subscriber Entries:

If you receive an error message or have difficulty creating a subscriber, you may need to add the
Insbridge user to the Windows Machine Keys.

1. Goto C:\Documents and Settings\All Users\Application Data\Microsoft\Crypto\RSA\MachineKeys.
2. Right click and select Sharing and Security. Select the Security tab.

3. Add the Insbridge user.

Add Database Connections:

Stay on the Main IBFA screen. Three databases must be added to IBFA:

e Subscriber: Global with Name: controller. This is a global database and is required for logging in
to the IBRU system. This is not unique to the subscriber.

e Subscriber: (Your Subscriber Name) with Name: security. This is a subscriber specific
database and is required for subscriber security information.

e Subscriber: (Your Subscriber Name) with Name: RM. This is a subscriber specific database and
is required for RateManager. This information will also be used when creating the RateManager
environment.

The setups are similar for all three databases. The description information following the first example will
be the same for the other two databases.

NOTE: If you have renamed the databases, please make note of the new names.

Step 2 — Adding a Global Database Connection:

Begin by filling out connection information for the IB_CLIENT database using the Global subscriber.

1. From the Insbridge page, click the Add Database Connection link. This will open the Connection
screen.
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/2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber.

Subscriber; Global W
Mame: Controller
Server: LocalHost Test Connection...

Server Type: | SQLServer W |

Catalog: IE_CLIENT

Catalog Type: | Other " |
Query Buffer:

Tablespace:

Schema:

User: 53

Password: LTIy

Save Cancel

Figure 24 Setting up the Global Database Connection

2. Select Global for the Subscriber.

3. Enter Controller for the Database Name. The name must be Controller. This cannot be changed
once you have saved it.

4. The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.
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9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner on page 9 if needed.

2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framewaork or unigue to the Subscriber.,

Subscriber: | Global w

Mame: |

Server: Test Connection...

Server Type: | SOLServer b |

Catalog:

Catalog Type: | Other w |

Query Buffer:
Tablespace:
Schema:
User:

Password:

Save Cancel

Figure 25 Adding a Database Connection

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed.

Step 3 — Adding a Security Database Connection:

1. Next, add the security database. Select the Add Database Connection link again.
2. Select Your Subscriber. The security database is unique to the subscriber.

3. Enter Security for the Database Name. The name must be Security. This cannot be changed
once you have saved it.

4. The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.
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5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner on page 9 if needed.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

2 Connection -- Webpage Dialog @

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber.

Subscriber: Alamere Insurance b
Mame: Security
Server: LocalHost Test Connection...

Server Type: | SQLServer b

Catalog: IB_CLIENT

Catalog Type: | Other A
Query Buffer:

Tablespace:

Schema:

User: 53

Password: resenene

Save Cancel

Figure 26 Setting up the Security Database Connection
Step 4 — Adding an rm Database Connection:

1. Next, add the rm database. Select the Add Database Connection link again.
2. Select Your Subscriber. The rm database is unique to the subscriber.

3. Enter rm for the Database Name. This cannot be changed once you have saved it.
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4. The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IBRM_xxxx for the Catalog. This is the RM database you restored in step 5.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner on page 9 if needed.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridae Framework or unique to the Subscriber.

Subscriber: Alamere Insurance b
Mame: RM
Server: LocalHost Test Connection...

Server Type: | SQLServer b
Catalog: IERM

Catalog Type: | RateManager

Query Buffer:

Tablespace:

Schema:

User: ]
Password: resenene

Save Cancel

Figure 27 Setting up the RateManager Database Connection

NOTE: The Catalog Type must be set to RateManager when you are creating the Connection from
RateManager. If you leave it set to Other, you will receive an error.
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Creating Logical Environments:

Next, create the default rating environment for the RateManager system.
For a new installation it is recommended that you create one logical environment:
e RM —to handle rating and testing.

You can create additional environments at this time if necessary or you can add them in at a later time.

Step 5 — Creating a RateManager Environment:

It is recommended that only one RateManager environment be created.

1. Browse to SoftRater=>Explorer=>Subscriber name.

= Framework Administrator, (WINAPPDO1) - Windows Internet Explorer

@ (A | &] httpusLocaiostterajdefaute. asps] DIEIES
Fle Edt Yew Favortes Tools Help
- . »
T e I@Framewurkmmmustratw(wwAPPum) ] I 5~ B o - srpage - ) Tools v
ORACLE msurance Insbridge Framework Administrator Version 04.05.00 (x86)
x|
Settings _p—
E-d Insbridge g
E-E3 SoftRater
{3 Engine
i E-I3 Explorer Configuration Add Environment
i — add, edit, or remove envighhments from your Explorer configuration.
[ SoftData
42 Services
[ Logs # No envirenments found.
3 security
422 Softlibraries . .
Line-of-Business Management
@) rielp Your rating book of businesses are identified by an id and a description, There is no limit to the number of LOB's (ine-of-
business) that your Explorer can contain.
ID - DESCRIPTION
# Mo Lines found.
Virtual File Server Manangement
There are times when you must download SoftRater packages from different locations. These locations require & domain
name of an ip-address of the particular server.
DESCRIPTION - SERVER - TYPE - ENVIRONMENT
# No file servers found.
< | & Copyright @ 2000, 2009, Oracle andjor its affiiates. All ights reserved.
Done ®J Local intranet E100% -

Figure 28 Create a Rating Environment

2. Click on Add Environment.
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/2 Environments -- Webpage Dialog

Mame: RM_Default

A SoftRater configuration can support an unlimited number of environments.

Type: | Dewv

Secure: [ |

Save Cancel

Figure 29 Entering Name and Environment

3. Enter a Name and select a Type. The hame and type are totally dependent on how your IBRU

system is designed.

There are three types of Logical Environments:

o Development
e Quality Assurance

e Production

After you have entered your logical environment, you must define it.

Defining the Logical Environment

ORACI_E. Insurance Insbridge Framework Administrator

]
E-LA Insbridge
L_—_|Lj SoftRater

----- [ Engine

E||_j Explorer

- SoftData
-l Services
H-[J Logs

-3 Security

Settings

Figure 30 Obtaining Environment Information

Add Environment
Add, edit, or remove environments from your Explorer configuration.

INAM DESCRIPTIC

# EM_Default - Development

# QualitvControl - Quality Assurance
% SR BM - Production
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4. Select the Environments link under the Configuration header on the left hand side to enter the
configuration information for the newly created logical environment. You will be placed on the
Environments screen. The environments you previously setup will be listed. If an environment is
missing, you must return to the Configuration subtab and add it.

= Framework Administrator, (WINAPPOO1) - Windows Internet Explorer

@,\:/' | ] hetpufLocalhostteFajdefaut. asprd S|EIES

Eile Edit ‘iew Favorites Tools Help

W o [ 8 Framework Administrator (WINAPPODL) ]7| fi - B - Groee - Gk r
ORACLE msumnce Insbridge Framework Administrator Version 04.05.00 (x86)
x
B3 nsbridge Settmgs
B0 SoftRater
| 23 Engine &
S cenfiguraion
Environments Environment(s) you may use for development purposes. Selecting an environment below will denote it as the default.
- softData
BB services Environment: RM_Default ®
[ Logs Test Environment...
3 security DB Server: WINAPPOO3
|4 SoftLibraries DB ServerType:
9 Hep DB Catalog: IBRM_Alamere
DB CatalogType:
DB Query Buffer:
DB Tablespace:
DB Schema: b
DB User: sa
DB Password: sessenes
Engine Type:
Engine Location: LOCALHOST
Engine EnvDef: Discover
Environment(s) you may use for quality assurance purposes. Selecting an environment below will denote it as the default.
Environment: QualityControl o]
Package Location:  C:\Insbridge \SRP Test Environment. ..
DB Server: WINAPPOO3
DB ServerType:
DB Catalog: IB5R_Alamere
DB CatslogType:
DB Query Buffer:
£ Tabl o
< | (¥ Copyright © 2000,2009, Crade and/or its affiiates. Al rights reserved.
Done %J Localintranet 100% +

Figure 31 Editing Environment

5. The Environment Name will be complete. No changes are needed.
6. RateManager environments will not have a Package Location. No entry will be allowed.

7. Enter in the DBServer name or IP address. This is the database server where the RateManager
database was restored.

8. The DB Server Type will be SQL Server.

9. The DB Catalog is the name of the RateManager database restored in SQL Server.

10. The DB Catalog Type is RateManager.

11. DB Query Buffer, DB Tablespace and DB Schema are not required for a RateManager
environment.
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12.

13.

14.

15.

16.

Enter the DB User name and Password.
The Engine Type is Windows.

The Engine Location default is LOCALHOST. Most RateManger installations have a local
engine location. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located. Do not change LOCALHOST to the name or IP
address of the local machine.

The Engine EnvDef default is a blank field. Most RateManger installations do not require an

entry in this field. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located.

Click Save to save your entries. After you have saved your settings, a new tab will be displayed,
Content. This tab will not be needed for a new installation.

No further entries are required at this time. If you want to make additional entries you can.
Additional environments can be added at any time.

If you are running a Windows only environment you can set up your SoftRater databases at this
time. Please see Chapter 4 Creating a SoftRater Environment for instructions.
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STEP 7 — VERIFYING THE COMPONENT SERVICES

Next, you should verify the component services.
1. Click Start=>Administrative Tools=»Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>My Computer=>COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed
underneath each compartment.

omponent Services
#. Fle Action  Wiew window  Help |_l_|- = x|

A il JEREN 7l
[_ Console oot — Actions
B Compaonent Services J
=[] Computers ; )
= .1_":_ [y Compuker ‘ : More Actions »
B[] COM+ Applications
COM+ Explorer
COM+ QC Dead Letter Gueue Listener
COMH+ Ukilities
Insbridge Com+ Administrator 3.5
Insbridge Com+ SoftRater Engine
Inshridge Cam+ SoftRater Library
5P System Application
| DCOM Config
| Running Processes
" | Distributed Transaction Coordinator
{a] Event viewer (Local)
. Services (Local)

Component Services -

i SE SN SNENENE

FHEEEE ]

Figure 32 Component Services

There should be 3 Insbridge Com+ Applications libraries:

e Insbridge Com+ Administrator 3.5
e Insbridge Com+ SoftRater Engine
e Insbridge Com+ SoftRater Library

Please note that you will not have to make any changes to any COM+ Application library. The
installation will automatically apply the Insbridge user name and password that you created
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earlier to the necessary libraries. If you change the password, you will have to change the
password in all three of the Insbridge Com+ libraries. On each library, right click, select
Properties, select the Identity tab, enter in the new password.

NOTE: If any COM+ library is missing, run the IBRU install again from the msi file and choose
uninstall. Then rerun the IBFA install. Uncheck the RateManager Install. Then check
again to see if all the libraries are listed. If they are still not listed, please log a Service
Request using My Oracle Support at https://support.oracle.com/.

Older instances of Insbridge may also have a fourth Com+ library.
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STEP 8 — ALLOWING FOR WCF ACTIVATION

WCF Activation is required for web services. RateManager makes call using IBFA web services.
If this is not activated, users will experience errors.

1. Select Start>Administrative Tools-> Server Manager.

2. Select Features Summary. Scroll through the list to verify WCF Activation has been
activated.

3. If not, select Add Features. The Add Features Wizard will be displayed.

Add Features Wizard E
= ]

E |

gﬂ Select Features

@

Select one or maore Features to inskall on this server,

Confirrmation Features: Descripkion:

Windows Communication Foundation
Progress = \MET Framework 3.0 Features (Installed) = A e
Resulks “MET Framework 3.0 {Installed) Process Ackivation Service ko imoke
%P3 Wiewer (Installed) applications remately over the
F activation (Installed) nebwark using protocols such as
|: BitLacker Drive Encryption HTTP, Message Queuding, TCP, and

named pipes, Conseguenthy,

L] BITS Server Extensions applications can start and stop

|: Zonnection Manager Administration Kk dynamically in response ta incoming
[] Deskiop Experience wark items, resulting in application
|: aroup Policy Management hosting that is more robust,

[ Internet Printing Client manageable, and efficient.

|: Inkternet Storage Mame Server
[ LPR. Port Monitar
[E Message Queuing (Installed)
[ mMultipath 1fo
[] Metwork Load Balancing
[] Peer Mame Resolution Protocol
[ Quality Windows audin Yideo Experience
|: Remote Assistance
[] remate Cifferential Compression
Remote Server Administration Tools {Installed)
[] removable Storage Manager LI

I ma e LTI Dlemen s

More sbout Features

< Previous | [dExt = | Install | Zancel I

Figure 33 Selecting WCF Activation

4. Select WCF Activation. Click NEXT.
5. Confirm your selection and click INSTALL. The installation will proceed.
6. You can close out when complete.
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STEP 9 — INSTALLING THE OBI PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in RateManager or
IBFA, you do not need to install this program.

1. Unzip the OBI_PUBLISHER

£ 0BI Publisher Setup A=

0Bl Publizher (

At

o)

Release Maokes,

Install l [ Zancel

Figure 34 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.

3. When complete, click Close.

4. In order for OBI Publisher to be available to users, you must start the Insbridge
Message Service. The Insbridge Message Service can be started from IBFA or from the
Server Manager.
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STEP 10 — STARTING INSBRIDGE SERVICES

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task
Manager is a task queue that lists the tasks that are scheduled to be performed as well as the last
time the task was run and the status.

Insbridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly (process)
for execution, These processes may take resources and time to execute, Please consult with you system admin before
configuring the number of listeners per process,

| Batch Rating " | View Messages Edit Process Configuration

If vou see this message, yvou have not requested a listing from the selected spoke client. Clicking
View Messages will provide yvou with a list view of the first in - first out messages that are waiting to
execute.

Insbridoe Task Manager Stop
The Insbridge Task Manager gives you the ability to execute daily, weekly, hourly, ar by the minute.

View Tasks (This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS

Figure 35 Insbridge Services Screen

1. InIBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click Start. After a few seconds, the buttons will
refresh to indicate that the service is started.

3. Nextto Insbridge Task Manager, click Start. After a few seconds, the buttons will refresh
to indicate that the service is started.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This
information may be needed if you have to make a request to your company’s
infrastructure and request the security team to open the ports used by Publisher.
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STEP 11 — PERFORMING UPDATES IN RATEMANAGER

There are two updates that should be done in RateManager prior to creating user groups and
users:

e Step 1 — Running Database Updates

e Step 2 — Updating Preferences

Entering RateManager:

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where the
INSTALLTIONSERVERNAME is the server where RateManager was installed.

This will place you on the RateManager login screen.

1. To login for the first time, select your company from the drop down menu. If you have
created only one company, a drop down menu will not be presented.

2. The user name is demo.
3. The password is password.
After running database updates, it is recommended that you update the demo user password.

Users and User Groups can be created after any database updates are run and preferences have
been set. For more on user management, please see the RateManager Tools User Guide.

NOTE: If you log into RateManager and Tools is the only option, you must perform a database
update.

NOTE: If you are having difficulties logging into RateManager, please check the error logs in
IBFA.
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RUNNING DATABASE UPDATES IN RATEMANAGER

If you log into RateManager and Tools is the only option, you must perform a database update.
After you perform the database updates, to view all menu options, click File->Reload.

/= Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explore

ORACLE’ Insurance Insbridge RateManager
File | Tools Help

3 Database » [ Backups
% Updates

Hom

Figure 36 Tool Mandatory Update

On the DB Updates screen, the current version will be highlighted and the status will be Current.
The updates below the current version will be grayed out. These updates cannot be run again.
Current updates can be re-run if necessary. You will receive an error message if you attempt to
run a lower version update. Any version update above the current version will also be grayed out
but will be available for executing.

New installations may show 04.05 as current but still have only the Tools option available. You
may have to run the current script again. To see if you have complete access to RateManager,
click File>Reload to refresh the system.

1. Navigate to the Tools>Database->Updates.

2. The Updates tab will be displayed. Select the database you want to view from the Show
updates for drop down. The database updates for your selection will be listed. The last
column, the Status column, will show you which update is the Current one installed.

OIRACLE Insurance Insbridge RateManager

File Modules  Tools  Help

i Home | () DB Updates x

@ DB Updates

EI Q Execute Update Script E Open Update Script E Save Update Script to File EE} Refresh _._.

Show updates for:| IERM v | P
Script Release Date Database / Status \
vO4.,05.00.00 5/1/2011 IBR.M Current
vO4.01.00.00 1171572010 IBF.M

vO<4.00.0.00 2/10/2010 IEF.M

Figure 37 Available Updates
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3. There are two ways to execute an update:
a. Directly in RateManager

b. In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting
the update showing Current. This will assure that the database showing as Current will have all
possible updates.

1. Highlight the update you want to run.

2. Click EXECUTE UPDATE SCRIPT. A warning message will be displayed.

3. Click OK to run the update or Cancel to return to the previous screen.

4. Do this for both the IBRM database and the IB_CLIENT database.

5. Click File>Reload to refresh the system.

A Confirm LUpdate -- Webpage Dialog, @

™ Are you sure you want to replace the
_!_/I current database's contents with the
- selected release script on disk?

e Ok | i cancel |

Figure 38 Updating Scripts in RateManager

In SQL Server

This method should be performed by a database administrator. No warning message will be
displayed if you execute scripts in the wrong order. You must know the name of the databases
you are updating. Please see Manual Updates to the IBRU Database.

UPDATING PREFERENCES

Administrators can edit web settings at any time from the Preferences option in RateManager.
Changes will take place after the user sessions have been ended. If web settings are changed
while the users are inside the module, the change will not be visible to them. Prior to users
accessing RateManager for the first time, it is recommended that Preferences be set.
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To Change Settings

1. Select Tools=>Preferences.

Tools Help

Manage Lines

Sudit

Import Programs

B e %

Security F
Database »
Change Password

371  Preferences

2. This will open the Preferences window. Select Web Settings.

& Oracle Insurance Insbridge RateManager [Preferences] -- Webpage Dialog

Preferences
.S
ser =
Web Settings
t-Home Page
dministratar
" ) Inshridge Configiml Path:  [C:\PROGRAM FILES\ORACLE\IGEU\INSERIDGE|FRAMEWORK\F
~-Web Settings
Messaging Server : [localhast | {S=cure channel) [
SoftRater Server : |I-oca|hcxsl | {Securs Channel) ]
Backup Shars Folder | |
Location:
Use Inshridge Com+
Admin:
Enforce Release Packaging:
Batch Package Threads:
Minimum Login User ID
Length:
User must change
password: (Cays)
Showe Crverride Date Mask:
Allowr Data Type Change:
Inactive Session Time Cut: {hrs)
Batch Results with Newline:
Online Help Server: |lDCB|hCEl |
My Recent List:
Default Proscoy Script T -
o |https/fvepad wipad.dat |
Change Control:
Maximum amount of b
¥ Save | @ Close |

Figure 39 Preferences Settings

3. Make any necessary changes. If you do not know all the settings, you can come back
and edit lat a later time. It is recommended that you update the ONLINE HELP Server
immediately.
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4. When you are finished, click SAVE to update your settings.

Web Settings

Insbridge ConfigXml Path

This is the path from IBFA. This pathway must match the IBFA path. You may need to change
this path if you have changed the path in IBFA. Please contact Insbridge support for further
information. It is strongly recommended that you leave the default.

Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you
have an especially large batch to run and you want to batch to a different server, you will have to
change server locations here. Unless necessatry, it is strongly recommended that you leave the
default.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the
backup file. If the location is local, you will use a local path. If the location is not local, you must
be a disk admin to change.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full)
package. False is the default setting.

If setto True, a release is required in order for a SoftRater (full) package to be created. If a user
wants to create a SoftRater (full) package in the Program Explorer module, a release must be
created in the Releases area first. This release must have the program added to it and be
unlocked. When the user creates the SoftRater package in Program Explorer, they will have the
option to select the Release they want this package to be placed into. If there is no release, or no
release that contains that program and is unlocked, then the user will be able to do RateManager
(local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to
finish faster by splitting the process into smaller processes that run quasi-simultaneously. On
multiprocessor systems, using multiple threads enables the operating system to assign the
threads to different processors.
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In addition, the Framework Administrator also enables you to change the administrator email
address for each client. When a process fails, an email will be sent to the person who initiated the
process, as well as to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even
a system crash. If you are unsure of how many threads to use, set the number to 1.
For single processor systems, Oracle Insurance recommends a maximum of 2
threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password.
This setting will only be active when you elect to have users change their password on the user
setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not
enabled, this field will not be visible.

Allow Data Type Change
The type of data associated with a parameter. RateManager supports three (decimal, integer and
string) data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True will allow RateManager users change the data type of a variable or
input. Setting this option to False will not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the
system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting
will place a carriage return between result files. A False setting will result in one continuous string
without a break.

Online Help Server

Online help is installed with RateManager. This setting should be the server name where
RateManager currently resides. Either a server name or an IP address can be entered here. If
needed, you can change the name of the server. For example, if the machine name is not the
same as the host name, you may need to change the name in order for online help to function.
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Change Control

If change control is on, it will be mandatory for users to enter a change control entry and
justification to any element or program when it is revisioned. If change control is off, the option will
not be presented.
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STEP 12 — EXPORT INSBRIDGE REGISTRY KEY FOR BACKUP

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge is
used to store all information for proper encryption of the SoftRater Packages (SRPs). This
registry key should be exported to a text file and stored in a safe location off the server.
This is a safety precaution and will not affect users currently accessing the IBRU system.
If you have to move RM/IBFA to a new machine or in the event of a catastrophic server failure,
where the RM/IBFA server is non-recoverable, the IBRU system will need to be reinstalled. When
RM/IBFA is re-installed on a new server, a new registry key will be created. The new registry key
will not match the registry key associated with any packages that have been created. In order to
load packages to the new server, you will need to restore the previous registry key.
You may also be requested to send to your registry key to support.

1. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.

2. Right click and select Export.

3. Select a storage location for the file and Save.

4. Close out of Registry Editor.

At the completion of this step, you may enter RateManager and begin working.

Oracle Insurance Insbridge Rating and Underwriting Installation Guide Page 59



Chapter 3

MANUAL UPDATES TO THE IBRU DATABASES

In the RateManager, Security, and SoftRater Database folders you will find the current database
scripts. The RateManager and Security database update scripts will take previous IBRM and
IB_CLIENT databases from version 04.01 to version 04.05.00 only. To go from a lower
version up to 04.05.00, you must enter RateManager.

NOTE: Oracle database updates must be performed directly on the Oracle database by an
Oracle DBA. Improper scripts updates can result in database failures. Oracle database
updates are not available on RateManager.

TO PERFORM DATABASE UPDATES FROM RATEMANAGER

The preferred method of updating the IBRM and IB_CLIENT databases is to go into
RateManager. If the administrator has DB User privileges and is the DB Owner of the database
as well as the disk administrator, database updates can be done on the
Tools>Database>Updates tab. If these privileges are not in place, an error message will be
displayed.

NOTE: If you need to go from an older version, such as 03.13, it is strongly recommended that
you enter RateManager and run the 04.00, 04.01 and 04.05 update scripts successively
from there.

To manually update a SQL Server database, you will be required to save off each update and run
them in sequential order in SQL Server. A DBA or a person with the proper permissions will need
to apply the database updates using Query Analyzer.

1. In RateManager, highlight the update you want to run. If you are going from a much lower
version of RateManager, you may have to save multiple files for each database.

2. Click Save Update Script to File. Your computers dialogue box will be displayed. Save
the file to a location of your choice. For IBRM scripts, it is recommended that you rename
the file to usp_IBRM_RO(version number).sql. For example the R4.0 update would be:
usp_IBRM_RO040.sql. For IB_CLIENT scripts, it is recommended that you rename the file
to usp_IB_CLIENT_RO(version number).sql. For example the R4.0 update would be:
usp_IB_CLIENT_R40.sql.

3. To view the update script prior to execution, highlight the update you want to view. Click
Open Update Script. The update script will be displayed in a separate screen.
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2 IBRU : v04.05.00.00 -- Webpage Dialog

~

—— Constraint
—— foriegn EHey
IF NOT EXISTS(SELECT *= FROM sys.indexes WHERE object_id = CBJECT _ID(N' [dbo].
[TYPES DATAL]"'") O&ND name = N'PE D5 TYPES Q')

print 'Missing [dbo].[PROGRAMS] Foreign Key [PE_D5_TYFES Q]'

GO
IF not EXISTS (SELECT * FROM sys.foreign keys WHERE object_id = OBJECT_ID(N®" [dbo].
[F¥K_PROGRAMS SYSTEM COUNTRIES]') ANMND parent object_id = OBJECT_ID(N'[dbo].
[PROGRAMS] "))

print 'Missing [dbo].[PROGRAMS] Foreign Key [FE_PROGRAMS SYSTEM COUNTRIES]'

GO
IF not EXISTS (SELECT * FRCM sys.foreign keys WHERE cbject_id = OBJECT_ID(N" [dbo].
[FK_IMPORT PROGRAM VALUE TMPORT PROGRAM]') AND parent object_id = OBJECT ID(N®" [dbo].
[IMPORT PROGRAM VALUE]'})

print 'Missing [dbo].[IMPORT PROGRAM VALUE] Foreign Key
[FK_IMPORT PROGRAM VALUE TIMPCORT PROGERRAM'

GO
if NOT exists (zelect * from dbo.sysobjects where id = object id(N'[dbo].
[FK_IMPORT TEMPLATE PROGRAMS]') and CBEJECTPROPERTY (id, N'IsForeignEey') = 1)

print 'Missing [dbo].[IMPCORT_TEMPLATE] Foreign Key
[FE_IMPORT TEMPLATE PROGRAMS]'

GO
if NOT exists (select * from dbo.sysobjects where id = object_id(N' [dbo].
[FK_PROGRAM VERSIONS PROGRAMS]') and OBJECTPROPERTY (id, N'IsForeignKey') = 1)

print ‘Missing [dbo].[PROGRAM VERSIONS] Foreign Key
[FE_PROGRAM VERSIONS PROGRAMS]'

GO
IF NOT EXISTS (SELECT * FROM syz.foreign_ keys WHERE object_id = OBJECT_ID(N®" [dbo].
[FE_LOOEUPVARS PROGRAMS]') AND parent object_id = OBJECT _ID(N'[dbo].[LOCEUF WVARS]'))

print ‘Missing [dbo].[LOCKUP VARS] Foreign Key [FE_LOOXKUPVARS PROGRAMS]'

GO
IF NOT EXISTS (SELECT * FRCM sy=s.foreign keys WHERE cbject_id = OBJECT_ID(N® [dbo].
[FK_INSTRUCTIONS GROUPS PROGRAMS]') AND parent object_id = OBJECTI_ID(N® [dbo].
[INSTRUCTICNS_GROUPS]'))

print 'Misz=ing [dbo].[INSTRUCTICNS GROUPS] Foreign Eey
[FK_INSTRUCTIONS GROUPS PROGRAMS]' v

%
Figure 40 Script Viewer

4. |If this is the script you want to run, open Query Analyzer in SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following
database queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual
database.

5. Open up the DB script updates from the download file. You can open in any program
you want, such as Notepad. Begin with the next sequential update. For example, if you
are going from R3.13 to 04.05.00, open 04.00 first.
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Figure 41 Updating Database

10.

11.

12.

13.

14.

15.

16.

17.

18.

Select the database you want. In SQL Server Management Studio, create a new
Database Engine Query, File»New->Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. You must run the updates in sequential order. Run each update
until you run the 04.05.00 update. Then continue on to the next database.

For example, if you want to update the IBRM database in SQL Server, select the IBRM_
database. In SQL Server Management Studio, create a new Database Engine Query,
File>New->Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 04.05.00 update. Then continue
on to the next database.

For example, if you want to update the IB_CLIENT database in SQL Server, select the
IB_CLIENT database. In SQL Server Management Studio, create a new Database
Engine Query, File>New->Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 04.01.00 update. Then continue

on to the next database.

After the scripts have been run, return to RateManager. Click Refresh Listing. The
status should show current and the full RateManager menu should be displayed

The updates are now properly applied and users can log back in to the system.

Oracle Insurance Insbridge Rating and Underwriting Installation Guide Page 62



Chapter 4
CREATING A SOFTRATER ENVIRONMENT

SoftRater databases can be added at any time after installation. If you are running a Windows
only environment utilizing SQL Server, you can set up your SoftRater databases at installation.
This type of set up has all environments on a single Windows server with a separate database
server. If you want to create an environment on a machine that is separate from the Full
RateManager install, then please see the corresponding SoftRater Installation Guide:

o SoftRater for Windows Installation

o SoftRater for WebLogic Installation

o SoftRater for WebSphere Installation

o SoftRater for JBoss Installation
There are two steps:

1. Restore the IBSR databases in SQL Server. You can restore as many as you need. For this
example, we will restore an IBSR_QA database. This will be a quality assurance database for
testing purposes.

2. Enter IBFA and Configure a QA logical environment.
We will have in place:
a. A full RateManager installation
b. Subscriber

c. Database connections

STEP 1 — RESTORING THE IBSR DATABASE

This step follows the instructions of Step 5 in the Full RateManager Installation, Chapter 2.

1. Located in the Insbridge Installation Directory:

¢ SQL Server
- SoftRater — IBSR
0 Latinl _General BIN
= DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General CP1_CI_AS
= DATABASE_BACKUP_IBSR_TEMPLATE.bak
0 Update:Usp_IBSR_v04.05.00.sql

NOTE: The Update:Usp_IBSR_v04.05.00.sql script is for updating a previous release and will
not be used in a new installation.
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2. Select the SoftRater backup file you want to use, case sensitive or non-case sensitive.

3. Copy the file to an appropriate database folder on the machine where SQL Server is
installed. For example, [Drive]:\Program Files\Insbridge\Databases. If you are unsure of a
location, please consult with your database administrator.

4. Rename the file. It is not required but it is strongly suggested that the database file
names be changed from TEMPLATE to something that defines the databases more
accurately. At a minimum, it is recommended that you remove “ TEMPLATE” from the
name. You can change the names after they have been restored also. In this example,
we will use IBSR_QA.

5. Open the SQL Server Management Studio either on the server or remotely using either
an administrative account with sa privileges or as the sa account.

NOTE: If you do not have SQL Server Management Studio, check to see that the SQL Server
Client has been installed. For a SQL Server install, you must have the SQL Server Client
installed.

6. Go to Databases.

7. Right click on Databases.

8. Select Restore Database... A separate screen will be displayed.

9. Enter your IBSR_QA database name in To Database:.

10. Select From Device. Click ... to browse to the location where the database files were
placed in step 3.

11. Select your database IBSR_QA.BAK.

12. Click OK. Your database will be populated.

13. Verify your information. Check the Restore box.

14. Click OK.

15. If the database was restored successfully, it will be displayed in the database folder. If
not, please correct any errors and try again.

16. Once the databases are restored to SQL Server, you will need to create or assign a SQL

Server user account for the application. This user will be used for the connection to the
databases when setting up the connections from the Insbridge Framework Administrator.
Make note of the account you want to use. This information will be entered into the
Insbridge Framework Administrator.
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STEP 2 — CONFIGURE A QA LOGICAL ENVIRONMENT

This step follows the instructions of Step 6 in the Full RateManager Installation, Chapter 2.
1. Enter IBFA.
2. Browse to SoftRater>Explorer=>>Subscriber name.
3. Click on Add Environment.

4. Enter a Name and select a Type. For this example, we will create the Quality Control
environment with a type of Quality Assurance.

5. Select the Environments link under the Configuration header on the left hand side to
enter the configuration information for the newly created logical environment. You will be
placed on the Environments screen. The environments you previously setup will be listed.
If an environment is missing, you must return to the Configuration subtab and add it.

(= Framework Administrator (WINAPPOO1) - Windows Internet Explorer

G - 2 hupiocahostisrajcetaut aspd ¥ [+ %
Ele Edt Wiew Fsvortes Took Help
w e I (& Framework Administrator (WINAPPODL) liw P B = v heage - GhTeok v
ORACLE msurance Insbridge Framework Administrator Version 04.05.00 (x86)
]
=M Insbridge SRS
53 SofRater
| E-C3 exlorer Configuration
Environments Enviranment(s) you may use for development purposes. Selecting an enviranment below will denote it a5 the defauit.
----- 3 softData
3 services Environment: RM_Default ®
553 Logs Test Environment...
[ Security DB Server: WINAPPOOS
155 Softioraries DB ServerType:
@) Help DB Catalog: IBRM_Alamere
DB CatalogType:
DB Query Buffer:
DB Tablespace:
DB Schema: 0
DB User: sa
DB Password: ssssnane
Engine Type:
Enginclocation:  LOCALHOST
Engine EnvDef: Discover
Enviranment(s) you may use for quaiity assurance purposes. Selecting an environment below will denote it as the defauit.
Environment: QualityContral (@]
Package Location:  C:\Insbridge|SRP Test Environment...
DB Server: WINAPPOOS
DB ServerType:
DB Catalog: IBSR_plamere
DB CatalogType:
DB Query Buffer:
N v
< | 3 Copyright © 2000, 2009, Orade andjor its affiiates. Al rights reserved.
Done &4 Local intranet & 100% -

Figure 42 Editing Environment
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10.

11.

12.

13.

14.

15.

16.

17.

The Environment Name will be complete. No changes are needed.

Enter in the file path where you want packages stored in the Package Location. Use the
Test Environment option to have the location created for you.

Enter in the DBServer name or IP address. This is the database server where the
SoftRater database was restored or created.

Select the DB Server Type that you are using.

The DB Catalog is the name of the SoftRater database restored in SQL Server. For this
example, we would enter IBSR_QA.

The DB Catalog Type is SoftRater.

DB Query Buffer, DB Tablespace and DB Schema are not required for a SQL Server
database.

Enter the DB User name and Password.

The Engine Type is Windows.

The Engine Location is the location of where you installed the SoftRater engine. For this
example, we are utilizing the same machine where we installed the Full RateManager
installation. We will enter LOCALHOST.

The Engine EnvDef can remain blank.

Click SAVE to save your entries.
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Support

CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System
product, please log a Service Request using My Oracle Support at https://support.oracle.com/.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com

TTY ACCESS TO ORACLE SUPPORT SERVICES

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, seven days a week. For TTY support, call
800.446.2398.
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